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第 3 章 　 デザイ ン フ ローと ラ ンマネージャー

　 本章では Lattice Radiant のデザイ ン フ ロー と、 複数のイ ンプ リ メ ンテーシ ョ ン （Implementation） を複数 
CPU コ アで並列処理させる ラ ンマネージ ャー （Run Manager） について記述し ます。

3.1 処理プロセス とデザイ ンフ ロー

3.1.1 プロセスの概要

　 Lattice Radiant の各処理プロセスのフ ローと設計制約フ ァ イルの関係を図 3-1 に示し ます。 主プロセスは  
デザイ ン ・ エン ト リ ー以降の論理合成、 マ ッ ピング （MAP）、 配置配線 （PAR）、 出力フ ァ イル生成 （Export
Files/Bitgen） です。 各プ ロ セスには処理に密接に関連する ポ イ ン ト ツールや、 それぞれ所定の入力 ・ 出力
フ ァ イルがあ り ます。 Radiant では処理時間の効率化のために、 各プロセス出力を統合化し て UDB （Unified
Data Base） と呼ぶフ ァ イル （拡張子 *.udb） になっています。

図 3-1. Lattice Radiant のデザイ ンフ ロー と設計制約フ ァ イル

　 ス ト ラ テジーは前章で記述し た通 り 、 各主プ ロ セ ス / サブプ ロ セ スに作用する設計制約 （Constraints、
Preferences） やオプシ ョ ン設定を一元管理する機構で、 Radiant も Diamond から継承し ています。 主プロセス
の概略は以下の通 り です。

デザイ ン ・ エン ト リー

　 実装に用いる HDL （RTL） ソース フ ァ イルをユーザーが用意し、 操作し ますので、 コマン ドやア イ コ ン
などはあ り ません。 殆どの場合は回路実装に PLL やブロ ッ ク メ モ リ ー （EBR） と いったマ ク ロ を含みま
すが、 IPCatalog と呼ぶモジュール生成ツールを用います。 これら を イ ンプ リ メ ンテーシ ョ ンご と にプロ
ジェ ク ト にイ ンポー ト し ます。

論理合成 （Design Synthesis） プロセス

　 HDL ソース フ ァ イルからゲー ト レベルのネ ッ ト リ ス ト （EDIF） に変換し ますが、出力フ ァ イルは Lattice
独自の *.udb （Unified Data Base） で、 テキス ト エデ ィ ターでの閲覧はでき ません。 デザイ ン ・ エン ト リ ー  
と し て *.vm （Structural Verilog） フ ァ イルを用いる こ と もでき ます。 論理合成ツール と し てはイ ンプ リ メ 
ンテーシ ョ ンご と に Synplify Pro か LSE （デフ ォル ト ） のいずれかを選択 ・ 指定し ます。 サブプロセス と 
し て、 タ イ ミ ング解析と シ ミ ュ レーシ ョ ン用 Verilog フ ァ イル （*.vo） 生成があ り ます。
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マ ッ ピング （Map Design） プロセス

　 主にフ リ ッ プフ ロ ッ プ （”FF”、 レジス タ） や LUT （Look-Up Table） を用いた記述になっている、 前プ 
ロセスで生成し たデータベースから、FPGA デバイ ス と し て実際に集積し ている論理 リ ソースであ る ” ス
ラ イ ス （SLICE） ” などに変換するプロセスです。 単一ス ラ イ スに割 り 当てる FF や LUT の組み合わせを
決定し （Packing） 、 仮のネ ッ ト リ ス ト を生成し ます。 このプロセスは各ス ラ イ スへの論理的な変換のみ
であ り 、 物理的にチ ッ プ上のどの位置のス ラ イ スに割 り 当て るかは決められていません。 こ のプロセス
に伴 う タ イ ミ ング解析は、 アルゴ リ ズム と し て想定し ている仮の配線遅延時間を用いる こ と で、 タ イ ミ
ング制約を満たすよ う な処理が行われます。 サブプロセス と し て タ イ ミ ング解析があ り ます。

配置配線 （Place & Route Design） プロセス

　 マ ッ ピングでの仮ネ ッ ト リ ス ト に対し て、 ス ラ イ スの物理的な配置 （Placement） やス ラ イ ス間の接続経
路 （Routing） を決定し、 ネ ッ ト リ ス ト を生成し ます。 こ の配置および配線処理は、 STA （静的タ イ ミ ン
グ解析） エンジンによ る タ イ ミ ング制約に対する解析処理 と の繰 り 返し実行にな り ます。 サブプロセス
と し て、 PAR タ イ ミ ング解析と I/O タ イ ミ ング解析があ り ます。

出力フ ァ イル生成 （Export Files、 bitgen） プロセス

　 配置配線後のネ ッ ト リ ス ト から、 デバイ スへの書き込みデータ （.bit、 .jed） を生成し ます。 サブプロセ
ス と し て、 タ イ ミ ング （実負荷） シ ミ ュ レーシ ョ ン用遅延フ ァ イル （*_vo.sdf） および Verilog フ ァ イル
（*_vo.vo） の生成や、イ ンプ リ メ ンテーシ ョ ンで使用されている IO タ イプのみを含む IBIS フ ァ イル（.ibs）
の出力などがあ り ます。

3.1.2 設計制約フ ァ イルの適用

　 Lattice Radiant では図 3-1 に緑丸で示す三タ イプの設計制約フ ァ イルがエン ト リ ーでき ます。 二種類あ る  
論理合成ツールの う ち、 LSE （Lattice Synthesis Engine） には *.sdc か *.ldc、 Synplify Pro には *.sdc か *.fdc を   
適用でき ます。 これら フ ァ イルを生成する GUI ツールは ”Pre-Synthesis Timing Constraint Editor” です （*.fdc   
を除 く ）。 第 15 章をご参照 く ださい。

　 一方、論理合成の後のマ ッ ピング以降のプロセス（Post-Synthesis）に作用する制約フ ァ イルが*.pdc（Physical
Design Constraint） です。 同様に GUI ツールのタ イ ミ ング制約エデ ィ ター （Post-Synthesis Timing Constraint   
Editor） で作成でき ます。 *.pdc にはピン配置指定などのタ イ ミ ング以外の制約も併記されます。 第 15 章と
第 16 章をご参照 く ださい。

　 また、 Lattice Radiant には 『制約プロパゲー ト ・ エンジン』 （Constraint Propagation Engine:CPE） と よぶ機   
能が組み込まれています。 デザイ ン内に IP Catalog で生成し た IP やマ ク ロ などが組み込まれている場合、 通 
常それらはデザイ ンの下位階層に置かれる ため、 生成時に付随し て得られる これら単独の制約フ ァ イルに含
まれる各項目は、 デザ イ ン全体か らする と イ ン ス タ ン ス化のためにネ ッ ト 名やポー ト 名などが不一致 と な
り 、 そのま まではデザイ ンには適用でき ません。 CPE はそ う し た下位層の IP やマ ク ロの制約を評価し て、 適
用するか無視するかの判断 ・ 処理を行います。 CPE が書き出す制約フ ァ イルは論理合成ツールにも渡されま
す （LSE には *.ldc、 Synplify Pro には *_cpe.ldc）。 詳細は第 15.5 節、 或いはのオン ラ イ ンヘルプ （User Guides  
→ Applying Design Constraints → Constraint Propagation） をご参照 く ださい。

3.1.3 バーチャル I/O フ ロー

　 Lattice Radiant には 『バーチャル I/O フ ロー』 があ り ます。 通常のフ ローでは、 デザイ ン ・ ト ッ プの I/O 
ポー ト 数が多 く て ターゲ ッ ト ・ パッ ケージに収ま ら ない と、 マ ッ プエラーにな り 処理が停止し ます。 このフ
ローでは適宜 I/O を ” バーチャル ” 指定する こ と で、 配置配線まで処理を実行する こ と が可能にな り ます。
デザイ ン初期段階での リ ソース見積も り や性能的な評価、或いは独自の IP 作成時などに有用です。 これにつ
いては第 16.2.2.2 項で記述し ます。

3.1.4 その他の機能

Nexus シ リ ーズには FPGA を コ ンフ ィ グレーシ ョ ンする ビ ッ ト ス ト リ ームの暗号化などのセキ ュ リ テ ィ ー
機能があ り ます。 詳細はプロ グ ラマー （第 13.6 節）、 プロ グ ラ ミ ング ・ ユーテ ィ リ テ ィ （第 14.1.7 項） をご
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参照 く ださい。 また、 RTL の暗号化機能があ り 、 デザイ ンの IP 化に有用です （第 2.6.7 項参照）。

3.2 各プロセスの実行と結果の確認

3.2.1 プロセスの実行方法

　 各 メ イ ンプロセスは Lattice Radiant の上部ア イ コ ン列の下に表示されている四つのプロセス ・ ボ ッ ク ス ( 
図 3-2 の赤枠 ) から実行し ます。

図 3-2. プロセス ・ ア イ コ ン

１．実行するプロセスのボックス内をシングルクリックする、または

２．実行するプロセスのボックス内を右クリックすると表示されるアイテム内から選択する（図 3-2中 
央下部にMap Designの例）、または

３．プロセス・ボックス列の右端にあるアイコン をクリックすると表示される、小ウィンドウ(図 3- 
2右側）のいずれかをクリック

　 上記 ２ の方法において各プロセス ・ ア イ コ ン枠内を右ク リ ッ ク し て選択でき る ア イ テムには、 以下の 3 つ
があ り ます （PPP は Synthesis/MAP/PAR/Export）。

Run PPP: 選択し たプロセス、 およびそれ以前の未実行のプロセスが実行されます

Force Run PPP: 選択し たプロセスが実行済みの場合、 そのプロセスのみが再実行されます。 未実行の場   
合は [Run PPP] と同じ動作です

Force Run from Start: 論理合成から選択し たプロセス までの全てのプロセスが実行されます。

　 上記 １ または ２ の方法でプロセス を実行し た場合で、 第 3.5.1 項で記述する ”Show Task Detail View when    
flow starts” オプシ ョ ンがオン （デフ ォル ト 状態） の場合は、 図 3-2 の右側に示す小ウ ィ ン ド ウ （Task Detail   
View） が自動的にオープン し て進捗等を表示し ます。

3.2.2 サブプロセスの実行

　 既述の と お り 各プロ セスには、 メ イ ン処理に加えてそれぞれに付随するサブプ ロ セスがあ り ますが、 デ
フ ォル ト では図 3-2 の右端のよ う にイ ネーブルされている もの （水色箱の✓印があ る） と、 そ う ではないも 
のがあ り ます。 メ イ ンプロセスの実行時に継続し て実行し たいサブプロセスは行頭のボ ッ ク スがイネーブル
表示になっています。 シングルク リ ッ ク し て選択するか、 非選択に変更する こ と で所望の振る舞いにする こ
と ができ ます。

　 なお、Radiant2023.2 からはサブプロセス ”Place and Route Timing Analysis” がデフ ォル ト で必ず実行される    
よ う にな り ま し たので、 非選択にする こ と はでき ません。 完了する と緑のチェ ッ ク印がひ ょ う じ されます、
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3.2.3 プロセス実行状態の表示

　 各プロセス ・ ボ ッ ク スの表示は実行状態によ って以下のよ う にな り ます。

　 　 ： プロセスが実行されていない状態

　 　 ： プロセス実行中

　 　 ： プロセス実行済みでエラーな し （Success）

　 　 ： プロセス実行済みでエラーあ り （Fail）

　 プロセス実行中には、 プロセス ・ ボ ッ ク ス列左端のア イ コ ンが に変わ り ます。 処理を停止する場合

はこれを ク リ ッ ク し ます。 図 3-2 の右端にあ る小ウ ィ ン ド ウでは行頭の印が以下のよ う にな り ます。

　 　 ： プロセス実行済みでエラーな し

　 　 ： プロセス実行済みでエラーあ り

3.2.4 プロセス ・ レポー ト

　 各プロセス ・ レポー ト は、 テキス ト と HTML の ２ つのフ ォーマ ッ ト で出力されます。 HTML レポー ト は、
Radiant GUI 上部の Reports タブを選択する こ と で、 レポー ト ビ ュー表示にでき ます （図 3-3）。

　 左枠にプロ ジェ ク ト ・ サマ リ ーと プロセスご と のレポー ト リ ス ト が表示されますので、 所望のア イ テムを
選択し ます （図 3-4）。 いずれかを ク リ ッ クする と、 その右側のレポー ト ・ ビ ューに表示されます。 図 3-4 の  
例はマ ッ ピング ・ レポー ト を選択し ている状態です。

図 3-3. レポー ト ビ ュー表示

　 [Project] はプロ ジェ ク ト ・ サマ リ ー、 それ以外は各プロセス実行の結果に対する レポー ト です。 [Synthesis
Reports] の [Constraint Propagation] は IP Catalog で生成し たモジュールや IP が実装されている場合にのみレ  
ポー ト される項目です。 [Misc Reports] には [TCL Command Log] や [I/O SSO Analysis] があ り ます。

　 各レポー ト 名の先頭に、 ステータ ス を表すシンボルが表示されます。

： 正常終了し たプロセスのレポー ト

： プロセスが未実行で、 出力されていないレポー ト

： 実行中にエラーが発生し、 プロセスが未完了のレポー ト
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： デザイ ンやプロ ジェ ク ト に何らかの変更がな され、 それ以前に生成された （無効な） レポー ト

図 3-4. レポー ト ビ ューの表示を選択するプロセス ご と のア イ テム

　 HTML 形式と共に生成されるテキス ト 形式のレポー ト 拡張子は、 以下の通 り です。

表 3-1. プロセス と レポー ト フ ァ イル拡張子

プロセス名
テキス ト 形式のレポー ト

フ ァ イル拡張子

Synthesize Design （論理合成、 Synplify Pro） * .srr

Post-Synthesis Timing Analysis （論理合成後のタ イ ミ ング解析） .tws

Map Design （マ ッ ピング） .mrp

Map Timing Analysis （マ ッ ピング後のタ イ ミ ング解析） .tw1

Place & Route Design （配置配線） .par

Place and Route Timing Analysis （配置配線後のタ イ ミ ング解析） .twr

Export Files （.bit / .fea フ ァ イル生成） ** .bgn

注 * ； LSE では HTML のみで、 *.srr は生成されません

　 ** ； Verilog / VHDL Simulation File や IBIS フ ァ イルの生成時はレポー ト には何も書き出されません

　 各プロセス レポー ト の詳細については、 それぞれの章で記述し ていますので、 別途ご参照 く ださい。

3.2.5 プロセス実行に伴 う メ ッ セージの表示

　 Radiant GUI の下部には 『Output』 と 『Tcl Console』、 そし て 『Message』 各ビ ューがタブで選択でき る表示  
領域があ り ます （図 3-5）。

　 Output ビ ューは実行ロ グで雑多な表示にな り ますが、 Message ビ ューでは各プロ セス実行後の種々 メ ッ 
セージを種別ご と に確認でき ます。 プロセス ご と に区分け されていますので、 プロセス名表示の行頭にあ る
▼印を ク リ ッ ク し て展開されている メ ッ セージを非展開にでき ます。

　 ビ ュー上部にあ る種別を選択するボ ッ ク ス を ク リ ッ クする こ と によ って、 該当する メ ッ セージの表示 ・ 非
表示が操作でき ます。 ク リ ッ ク ご と に切 り 替わ り ます。

　 　 ： エラー ・ メ ッ セージ
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　 　 ： ウ ォーニング ・ メ ッ セージ

　 　 ： 情報

　 また、 右端にあ る マーク では、 メ ッ セージ番号ご と に並び替え る （ソー ト する） こ と が

でき ます。 ク リ ッ クする ご と に切 り 替わ り ます。

図 3-5. Message ビ ューを タブで選択

3.2.5.1 メ ッ セージ ・ フ ィ ルタ リ ング

　 全ての メ ッ セージには ID 番号が付与されていて、 ID ご と に非表示に （ メ ッ セージ ・ フ ィ ルタ リ ング） す
る機能があ り ます。 大きいデザイ ンほど相当量の メ ッ セージが表示されますが、 Warning の中には無視し て
も構わないものが少な く あ り ません。このよ う な場合、メ ッ セージ行を選択後右ク リ ッ ク し て、[Filter Message 
with This ID] を選択する と （図 3-6）、 同一 ID の メ ッ セージが全て非表示と な り ます。

図 3-6. 特定 メ ッ セージのフ ィ ルタ リ ング

　 基本的な推奨設計フ ローと し てエラー メ ッ セージは勿論、 全ての Warning を確認し て無視でき るかど う か
を吟味する こ と が期待されます。 本機能はその作業を格段に効率化し ます。

　 フ ィ ルターを掛ける メ ッ セージ ID の リ ス ト は、 Radiant の起動 ・ 終了に関わらずプロ ジェ ク ト 毎に保持さ
れます。 フ ィ ルター対象か ら除外する ためには、 図 3-7 のよ う な操作で 「Filter Enable」 セルのチェ ッ ク ・  
ボ ッ ク ス を ク リ ッ ク し た後、 『Apply』 で戻 り ます。

図 3-7. フ ィ ルター対象を除外する操作
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3.2.5.2 メ ッ セージ ・ シビ リ テ ィ の変更

　 特定の メ ッ セージ ID を Warning から Error に上げるなど、 ” メ ッ セージ ・ シビ リ テ ィ ” を変更し たいケー 
スがあ るかも しれません。 その場合、 まず前項同様に メ ッ セージを選択し て右ク リ ッ ク し、 [Change Severity 
with This ID] を選択し、 種別を指定し ます （図 3-8）。 それ以降のプロセス実行に適用されます。

図 3-8. シビ リ テ ィ を変更する操作

　 シビ リ テ ィ を操作し た メ ッ セージIDの管理は、まず メ ニューバーから[Project]→[Message Promotion/Demo- 
tion ...] を選択し ます。 ”Message Promotion” ウ ィ ン ド ウが表示されます （図 3-9）。 このウ ィ ン ド ウでは三つ   
の操作ができ ます。

図 3-9. メ ッ セージの管理

　 ① リ ス ト されている ID の行を選択し、 右下の 『Remove』 ボタ ンで解除する こ と ができ ます

　 ②「IDs」セルに ID 番号を入力し て『Promote』ボタ ンを ク リ ッ クする こ と で、直接プロモー ト 指定ができ ます

　 ③左下の 『Export...』 ボタ ンでテキス ト フ ァ イル （*.pmt） に書き出し、 『Import...』 で取 り 込みができ ます

3.2.5.2 メ ッ セージ と テキス ト エデ ィ ターとのリ ン ク

　 メ ッ セージによ っては、 該当箇所 （フ ァ イル） を特定するためにテキス ト エデ ィ ターにジ ャ ンプする こ と
ができ ます。 当該 メ ッ セージを選択後、 右ク リ ッ ク し て [Locate in] → [Text Editor] を選択し ます （図 3-10）。

図 3-10. メ ッ セージの該当箇所をエデ ィ ターを起動し て表示

対象のフ ァ イルを表示し てエデ ィ ターが立ち上が り ます。 ツールオプシ ョ ンでユーザー指定のエデ ィ ターが
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登録されていれば、 そのエデ ィ ターで立ち上が り ます。 非該当の メ ッ セージの場合は [Locate in] はグレーア 
ウ ト し て選択でき ません。

3.3 配置配線プロセスの並列処理
　 一般的に配置配線 （PAR） プロセスが最も処理時間を要する処理です。 Radiant ではこのプロセスに限 り 、
複数コ ア CPU 搭載の PC では、 各コ アに並列処理させて時間を短縮する こ と ができ ます。 ただし、 ス ト ラ テ
ジー ・ オプシ ョ ンの一つ ”Placement Iterations” にデフ ォル ト の ’1’ 以外を設定し て （例えば 3 コ アでは 3 以 
上）、 PAR 処理を複数回実行させる場合に限 り ます。 詳細については第 3.4.8 項 （Multi Tasking Node List） を   
ご参照 く ださい。

　 なお、 実際に搭載されている コ ア数以上の値を設定する と、 処理性能が極端に悪 く な り ます。 コ ア数の設
定値は搭載されている コ ア数以下 （最大でも コ ア数 - １ ） に収める よ う にし ます。 また、 ラ ンマネージ ャー
で複数イ ンプ リ メ ンテーシ ョ ンを並列処理させる場合、 このオプシ ョ ン設定を行っている と想定以上のプロ
セスが同時実行されて し ま う こ と があ り ますので、 ご注意 く ださい。

3.4 ラ ンマネージ ャーによ る並列処理

3.4.1 ラ ンマネージ ャーの概要

図 3-11. ラ ンマネージャーの起動

　 ラ ンマネージ ャーは、 プロジェ ク ト 内に複数イ ンプ リ メ ンテーシ ョ ンがあ る場合、 一連の処理プロセス を
イ ンプ リ メ ンテーシ ョ ン単位で同時処理させる ためのツールです。 例えば配置配線プロセスで、 イ ンプ リ メ
ンテーシ ョ ンご と に ” コ ス ト テーブル ” （Placement Iteration Start Pt） を変えて並列実行でき ますので、 迅速   
に最適解を得る手段にな り 得ます。

3.4.2 ラ ンマネージ ャーの起動

　 メ ニ ューバーから [Tools] → [Run Manager] の順に選択するか、 ツールバーのア イ コ ン を ク リ ッ ク し   
て起動し ます （図 3-11）。 ラ ンマネージ ャーは前回実行された時の状態で起動し ます。

3.4.3 実行する イ ンプ リ メ ンテーシ ョ ンの選択

　 ウ ィ ン ド ウの最左カ ラ ムには、 チェ ッ ク ボ ッ ク ス と共にイ ンプ リ メ ンテーシ ョ ン名およびス ト ラ テジー名
が リ ス ト さ れます。 ラ ンマネージ ャー処理は、 こ のチェ ッ ク ボ ッ ク スにマーク が入っている イ ンプ リ メ ン
テーシ ョ ンを対象と し ます （デフ ォル ト は全てチェ ッ ク無し）。

　 1 つずつチェ ッ ク を入れる こ と もでき ますが、 ラ ンマネージ ャー ・ ウ ィ ン ド ウ内で右ク リ ッ ク し て [Select
All] を選択する と、 全イ ンプ リ メ ンテーシ ョ ンにチェ ッ クが入 り ます。 同様に [Unselect All] を選択する と、 
全イ ンプ リ メ ンテーシ ョ ンのチェ ッ ク が外れます。
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　 また、 ラ ンマネージ ャー ・ ウ ィ ン ド ウ内で右ク リ ッ ク し て [Show/Hide Implementation] を選択する こ と で、 
イ ンプ リ メ ンテーシ ョ ンご と に表示 ・ 非表示の指定ができ ます。

3.4.4 ラ ンマネージ ャーの実行

　 ラ ンマネージ ャーの実行は、 ラ ンマネージ ャー ・ ウ ィ ン ド ウ内で右ク リ ッ クする と 現れるプルダ ウ ン メ
ニューから [Run] または [Rerun] を選択するか、ウ ィ ン ド ウ左上に表示されている同じ ア イ コ ンを ク リ ッ ク し 
ます。

　 [Run] を選択し た場合は、 各イ ンプ リ メ ンテーシ ョ ンの未実行のプロセスのみが実行されます。 [Rerun] を
選択し た場合は、 論理合成から再実行されます。 実行が終了後はこれら ア イ コ ンや メ ニューはア ク テ ィ ブに
な り ません。 イ ンプ リ メ ンテーシ ョ ンで何らかの変更がされる と、 再度ア ク テ ィ ブにな り ます。

　 処理中にラ ンマネージ ャーを一時的に中断する、 或いは停止する場合には、 ウ ィ ン ド ウ内で右ク リ ッ ク し
て現れるプルダウ ン メ ニューから [Pause] や [Stop] を選択するか、 ウ ィ ン ド ウ左上に表示されている同じ ア
イ コ ンを ク リ ッ ク し ます。

3.4.5 イ ンプ リ メ ンテーシ ョ ンのア ク テ ィ ブ指定

　 ラ ンマネージ ャー上で、 ア ク テ ィ ブでないイ ンプ リ メ ンテーシ ョ ン名を右ク リ ッ ク し、 現れる メ ニューか
ら [Set As Active] を選択する こ と で、 そのイ ンプ リ メ ンテーシ ョ ンをア ク テ ィ ブに指定でき ます。

3.4.6 ラ ンマネージ ャーのカス タマイ ズ

3.4.6.1 表示カ ラムの選択

　 ラ ンマネージ ャー上で表示する カ ラ ムは、 用意されている項目から選択し てカス タマイ ズする こ と ができ
ます。 ラ ンマネージ ャー上部の項目欄いずれかで右ク リ ッ クする と、 選択でき る項目が表示されます （図 3- 
12）。 項目名を ク リ ッ クする こ と でチェ ッ クの有無 （表示／非表示） を切 り 替え る こ と ができ ます。

　 デフ ォル ト で表示されない項目については、 まずフ ァ ン ク シ ョ ンキー 『F1』 を ク リ ッ ク し てオン ラ イ ンヘ
ルプの Run Manager セ ク シ ョ ンを呼び出し ます。 左枠でサブア イ テム [Reading the Run Manager Results] を選     
択する こ と で、 右枠にその内容が表示され、 その詳細記述は [Column Descriptions] 部にあ り ます。

図 3-12. ラ ンマネージャー上に表示する カ ラ ムの選択
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3.4.6.2 カ ラムの表示順の変更

　 表示されている項目名を選択し て ド ラ ッ グ＆ド ロ ッ プする こ と で表示順序を変更する こ と ができ ます。 ま
た、 カ ラ ムを ク リ ッ クする と、 そのカ ラ ムの指標に関し て ソー ト （並び替え） し て イ ンプ リ メ ンテーシ ョ ン
の表示順が変わ り ます。

3.4.7 実行結果のエ ク スポー ト

　 ラ ンマネージ ャーのウ ィ ン ド ウ表示をエ ク スポー ト （csv フ ァ イル出力） でき ます。 ウ ィ ン ド ウ内の適当
な位置で右ク リ ッ ク し て [Export...] を選択し ます。

3.4.8 CPU コ ア並列処理オプシ ョ ン と の併用

　 ラ ンマネージ ャーを使用する場合は、 PAR ス ト ラ テジー ・ オプシ ョ ンの ”Multi-Tasking Node List” は使用  
し ないこ と を推奨し ます。

　 PAR オプシ ョ ン [Multi-Tasking Node List] を使用し、 かつラ ンマネージ ャーで複数イ ンプ リ メ ンテーシ ョ  
ンを並列処理させる と、 意図する以上にプロセス （ス レ ッ ド） が同時に走る こ と にな り ます。 これによ り マ
シンが過負荷状態と な り 、 処理時間が極端に増加し て し ま う こ と があ り ます。

　 例えば [Multi-Tasking Node List] で、 コ ス ト テーブルの異なる PAR を 2 並列処理させる設定にし ている イ  
ンプ リ メ ンテーシ ョ ンを、更にラ ンマネージ ャーで 2 並列処理させた場合、最大 4 つの PAR プロセスが同時
に実行される可能性があ り 、 4 コ ア CPU のマシンでは他に何も処理ができな く な り ます。

3.5 環境設定オプシ ョ ン
　 Lattice Radiant では、 ユーザーが好みに合わせて環境設定ができ る よ う になっています。 メ ニューバーの 
[Tools] → [Options...] の順に選択する と開 く 「Options」 ウ ィ ン ド ウで各項目を設定でき ます ( 詳細はオン ラ  
イ ンヘルプをご参照下さい）。 図 3-13 は左側にあ る三つのグループで 「General」 部が選択されている場合の 
表示です。 「Color」 については関連記述があ るパッ ケージ ・ ビ ュー部 （第 16.4.1.1 項） をご参照 く ださい。

　 「General」 部の環境設定は、 大き く 以下の 5 項目 （タブ） に分かれています。

　 General ： 全般的な設定

　 Startup ： 起動し た際の動作に関する設定

　 File Association ： フ ァ イル拡張子と、 それを開 く プロ グ ラ ムの関連付け設定

　 Directories ： 論理合成ツール と シ ミ ュ レータのフ ォルダー設定

　 Network Setting ： ネ ッ ト ワーク接続 （プロ キシ ・ サーバー） の設定

図 3-13. 環境オプシ ョ ン設定ウ ィ ン ド ウ （一部）
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3.5.1 General タブ

　 このタブでは主に動作に関わる設定ができ ます。

Copy file to Implementation's Source Directory when adding existing file

既存のソース フ ァ イルをプロ ジェ ク ト にイ ンポー ト する方法のデフ ォル ト 値設定です（イ ンポー ト の
際に個別に選択する こ と もでき ます）。 デフ ォル ト （チェ ッ ク な し） は ” 選択し たフ ァ イルを イ ンポー
ト する ” 設定です。 チェ ッ ク を入れる と、 対象フ ァ イルを イ ンプ リ メ ンテーシ ョ ン下の ”source” フ ォ
ルダーにコ ピーし、 それを イ ンポー ト する設定にな り ます。

Archive all files under the Project Directory when archiving Project

フ ァ イル メ ニューから [Achieve Project] を実行し てアーカ イブ （プロ ジェ ク ト を圧縮保存） する場合 
の対象フ ァ イルの選択設定です。 デフ ォル ト （チェ ッ ク あ り ） では、 当該プロ ジ ェ ク ト と の関連を問
わずプロ ジ ェ ク ト フ ォルダー以下の全てのフ ァ イルおよびフ ォルダーが圧縮されます。 チェ ッ ク を外
すと、 当該プロ ジェ ク ト の再現に関連する （ソース） フ ァ イルのみが圧縮対象にな り ます。

Clear Output window before running process

プ ロ セ ス実行時のに関する設定です。 デフ ォル ト （チェ ッ ク あ り ） では、 プ ロ セ ス実行のたびに、
Output ウ ィ ン ド ウの前回の結果表示はク リ ア され、 新しい メ ッ セージのみが表示されます。 チェ ッ ク
を外すと プロセス実行のたびに メ ッ セージが追記されます。

Show Task Detail View when flow starts

「Task Detail View」 は図 3-2 内の右側にあ る小ウ ィ ン ド ウです。 プロセスボ ッ ク スのいずれかを ク   
リ ッ ク し て処理を実行し た場合、 デフ ォル ト （オン） ではこ のウ ィ ン ド ウが自動的にオープン し て進
捗等を表示し ます。 チェ ッ ク を外すと、 ウ ィ ン ド ウは開き ません。

Close start page after project open

デフ ォル ト （チェ ッ ク な し） ではプロ ジ ェ ク ト をオープン し て も ス ター ト ページはク ローズ し ませ
ん。 チェ ッ ク を入れる と ク ローズ し ます。

Maximum items shown in Recent item lists （0 ～ 32）

ス ター ト ページ ・ ビ ューに表示する、 直近に開いたプロジェ ク ト （Recent Project） の数の設定です。

Maximum implementation processes running in Run Manager （1~32）

ラ ンマネージ ャーで並列処理させる最大イ ンプ リ メ ンテーシ ョ ン数の設定です。使用する コ ンピ ュー
タの CPU コ ア数以下の値を設定する こ と が推奨です。

Accept message support agreement [View Agreement]

デフ ォル ト でサポー ト ・ アグ リ ー メ ン ト を許容し ます。 右側の 『View Agreement』 ボタ ンを ク リ ッ ク 
する と以下のよ う な メ ッ セージを表示し ます。 同意し ない場合はチェ ッ ク を外し ます。

Lattice Semiconductor would like to collect data on what software messages are being generated for your               
design. This information is completely anonymous and only consists of program name generating the message,              
the message ID, and the number of times the message occurred. Allowing this data to be collected will allow                  
Lattice to better prioritize which messages need more content developed helping customers complete their             
designs easier and faster. Making checkbox "Accept message support agreement" be checked will allow this              
data to be collected.

3.5.2 Startup タブ

　 こ こ では Radiant 起動時の振る舞いに関する三つの設定を行いますが、 タブ選択直後の表示は図 3-14 のよ 
う になっています。

　 最上部ではプルダウ ン ・ バーで [Show Start Page] が選択されています。 これは三つの選択肢の一つで、 他  
に [Open Previous Project]、 [Start with New Project Wizard] が選択でき ます。
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　 [Show Start Page] 選択時は、 Radiant 起動時にス ター ト ページを表示し ます。 [Open Previous Project] を選択    
する と、起動時に ク ローズ時に作業し ていた直近のプロ ジェ ク ト を自動的にオープン し ます。また [Start with 
New Project Wizard] を選択する と、 新規プロ ジェ ク ト 作成ウ ィ ザード がオープン し て新規作成ができ る よ う  
にな り ます。

図 3-14. ス ター ト ア ッ プ ・ オプシ ョ ン

　 第二の項目はツール更新の有無を検出する頻度に関する設定で、 次の三つから指定でき ます。

Automatic check for software update when Lattice Radiant Software Launches

　 Every time : 起動する ご と に検出を行います （デフ ォル ト ）

　 Daily : 日ご と最初の起動時に検出を行います

　 Weekly : 週ご と最初の起動時に検出を行います

　 第三の項目は IP 情報の取得についての設定です。

Automatic fetch IP list from IP Server daily

デフ ォル ト （チェ ッ ク あ り ） で IP 情報を IP サーバーから日ご と に自動取得し ます。 チェ ッ ク を外
すと、 ユーザーが操作し た時にのみ取得し ます。

　 第四の項目はコ ン ト ロール ・ デバイ スについての設定です。

Check Controlled Device License

デフ ォル ト （チェ ッ ク な し） では、 フ ィ ーチャー ・ ラ イ セン ス必要なデバイ ス フ ァ ミ リ ーを ター
ゲ ッ ト に し ているプロ ジ ェ ク ト を開 く と き、 ラ イ セン スが必要な こ と を示すポ ッ プア ッ プが表示さ
れ、 ユーザーに何らかのア ク シ ョ ンを促し ます。 チェ ッ ク を入れて イ ネーブルする と、 ツールが自動
的にラ イセン ス有無をチェ ッ ク し ます。

3.5.3 File Associations タブ

　 こ の タ ブでは、 各種フ ァ イ ル と それを開 く プ ロ グ ラ ムの関連付け を設定 し ます。 デフ ォル ト では全て
Lattice Radiant のプロ グ ラ ムが関連付け られています。 テキス ト エデ ィ ター （Source Editor） を日頃使用し て  
いる ツールに変更する場合を例に説明し ます。

　 まずエデ ィ ターを登録するために、 ウ ィ ン ド ウ右下の 『Add』 ボタ ンを ク リ ッ クするか、 任意行の [Default
Programs] カ ラ ムを ク リ ッ ク し て ”<Add Program...>” を選択し て、 プロ グ ラ ムの追加ウ ィ ン ド ウ Add （図 3-  
15 左下） を立ち上げます。 ブラ ウ ズ ・ ボタ ンから登録し たいプロ グ ラ ムの実行フ ァ イル （*.exe） をブラ ウ
ズ後に選択し ます。 「Display Name」 セルに Lattice Radiant 上での表示名を入力し、 『OK』 を ク リ ッ ク し て戻  
り ます。 こ のウ ィ ン ド ウの 「Argument」 セル入力は任意で、 プロ グ ラ ム起動時の引数の設定です。 例えば、
テキ ス ト エデ ィ ターの場合、 デフ ォル ト ではエデ ィ ター起動時にはフ ァ イル名のみが指定されていますが、
引数 と し て行数の指定をサポー ト し ている エデ ィ ターであれば適当な設定を行 う こ と に よ り 、 エ ラー メ ッ
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セージ等をダブルク リ ッ クする と問題の原因と なった行へカーソルが飛ぶよ う にな り ます （行数指定な しだ
と カーソルはフ ァ イルの先頭）。

　 登録が終了する と、 図 3-15 のウ ィ ン ド ウ下部の 「External Program」 セル （図 3-15 では非表示） には登録   
し たプロ グ ラ ム名が表示されます。

　 その後、登録し たプロ グ ラ ムに関連付け し たいフ ァ イル拡張子の行の [Default Programs] カ ラ ムを ク リ ッ ク 
する と、 プロ グ ラ ムが登録名で表示されるので、 それを選択し て関連付けが完了し ます。 関連付けプロ グ ラ
ムの追加は、 拡張子ご と に行 う 必要があ り ます。 過去に追加し たプロ グ ラ ムの履歴は 「External programs:」  
部の [Replace Tool] セルを二度ク リ ッ クする と表示されます。

図 3-15. 関連付けプロ グ ラ ムの追加

3.5.4 Directories タブ

　 このタブでは、 論理合成ツールや論理シ ミ ュ レータのパス設定を行います ( 図 3-16)。 バン ド ルされてい 
る もの以外の、 例えば正規版 Synplify Pro を使用する場合は、 ウ ィ ン ド ウ右上の 「UseOEM」 チェ ッ ク を外し、 
右端の 『...』 ボタ ンをからブラ ウズ し て実行フ ァ イルのあ る フ ォルダーを指定し ます。

図 3-16. ツールのデ ィ レ ク ト リ 設定
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　 同様に論理シ ミ ュ レーシ ョ ン と し て Active-HDL を使用する場合、同様に ”Simulation” セ ク シ ョ ンで右端の
『...』 ボ タ ンでブ ラ ウ ズ し、 実行フ ァ イルのあ る フ ォルダーを指定し ます。 第 10.2 節で記述する Simlation
Wizard によ るシ ミ ュ レーシ ョ ンで、 指定でき る シ ミ ュ レーターの候補表示に作用し ます。

　 これ以外に IP Catalog でモジ ュールや IP を イ ン ス ト ールする際のパス設定ができ ます。

3.5.5 Network Settings タブ

　 Lattice Radiant では、 ア ッ プデー ト 情報の検出や IP コ アのダウ ン ロード等でネ ッ ト ワーク接続が必要にな 
り ます。 社内ネ ッ ト ワーク などでネ ッ ト ワーク接続する際にプロ キシーサーバーを使用し ている場合は、 こ
のタブでサーバー情報なのネ ッ ト ワーク設定を行います。 ホス ト 名はポー ト 番号などはネ ッ ト ワーク管理者
に確認し て設定する よ う にし ます。

図 3-17. ネ ッ ト ワーク設定

リビジョン ページ 　　　　　内　　　容

2022.1 12  Rev.3.2.1 からバージョン・アップに伴い、Startupオプションの追加項目について記述

13 同、Directoriesオプションの画像を更新

(r1) 5  表3-1、タイポ “.map” --> “.mrp” に修正

2023.2 --  Rev.2023.2へのバージョン・アップに伴い見直しと更新

更 　 新 　 履 　 歴
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